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About Photo to FlashBook Professional 

Photo to FlashBook Professional is your easy way 

to batch convert photo into stunning flash album 

with amazing page-flipping animations and sound! 

Imagine being able to create digital magazines and 

catalogs that behave like actual paper books 

without any programming work! Once you've 

created your page-flipping masterpiece in Photo to 

FlashBook Professional, you can publish it to the 

web, via email, and even distribute it on CD-ROM, 

all without paying royalties! 

 

 

 

 

 

 

 

 
 

Note: This product is distributed on a "Try 

before-you-buy" basis. All features described in this 

documentation are enabled. The registered version 

doesn't insert a watermark in your generated 

page-flipping eBooks. 
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Product features 

1. Convert image to Adobe© Flash® based page-flipping eBooks. 

2. Output in 4 different formats: HTML, EXE, Zip and Burn to CD. 

3. HTML allows you to upload to a website to be viewed online. 

4. EXE and Zip allow you to send to your user by email to be viewed 

on their computer. 

5. Burn to CD allows you to burn to disk so you can send your user 

physical media for viewing on their computer. 

6. Preview the output effect instantly. 

7. Provides multiple scan optimize tools before designing template: 

flip, rotate, de-skew, crop, convert to B/W, gray scale, etc. 

8. Provide multiple templates (default provided or download from 

website). 

9. Set eBook size, choose landscape or portrait. 

10. Add watermarks text, image, dynamic date/ time etc to 

page-flipping ebooks. 

11. Define titles, keywords and other metadata. 

12. Define titles, icon, window size for EXE page-flipping ebooks. 

13. Define book margin size manually.  

14. Add encryption to protect created page-flipping eBooks. 
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15. Retain the book to center or not. 

16. Insert background music, always play or define times. 

17. Set background color and image. 

18. Set book reading from right to left (such as Arabic). 

19. Choose hard cover for eBooks. 

20. Set page-flipping time manually. 

21. Customize toolbar buttons to set permissions for downloading, 

printing, sharing and more. 

22. Set colors for toolbar, book cover, book shadows, bookmarks and 

more. 

23. Set scale for zoom-in function. 

24. Set control bars to "show" or "hide" in full screen. 

25. Define language for flash. 

26. Export and save settings for future uses. 

27. Set output name mode within batch conversion. 

28. Save current files and settings as project. 

Page-flipping eBook features 

With the page-flipping ebook you have created, your user will be able to: 

1. Drag the corner to flip a page. 

2. Click page shadows to flip a page. 
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3. Input login password to view eBook content. 

4. Auto-view flipbook repeatedly. 

5. Auto-flip eBooks after loading. 

6. View page thumbnails. 

7. Use button to control page, such as Previous, Next, First, Last etc. 

8. Flip pages automatically. 

9. View page-flipping ebook full screen. 

10. Search whole eBook. 

11. Print out the whole ebook or a range of pages directly. 

12. Download the uploaded page-flipping eBook from web site directly. 

13. Double-click to zoom in or zoom out. 

14. Zoom in/ out both pages. 

15. Share eBook url via email. 

16. Open or close page-turning sound. 

17. Open to a certain page in Browser by adding a suffix like this: 

index.html?pageIndex=4. 

Quick Start 

1. Launch the application via the desktop shortcut ; 
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2. Click the "1. Add File" Tab icon  to enter 

into Import image interface; 

 

3. Click icon to choose images from your 

computer; 

4. Click icon to convert images to flippingbook 

and enter into template setting interface; 

5. Define parameters for eBooks, such as Book, Tool Bar, Bookmarks, and 

then click the "Apply Change" icon ; 

6. Click "Publish" Tab icon to enter into Output 

interface; 

7. Choose Output Type from HTML, ZIP and EXE, here take 

as example; 

8. Click to set Output Folder as "C:\flipbook", input File Name 

as "demo"; 

9. At last, click icon to output created page-flipping eBook. 

 
You can open the "flipbook" folder in "C:", there are three files in this folder: 
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Open the "demo.html" file to view your created page-flipping book via Web Browser, 

such as Internet Explorer, Google Chrome, Firefox, etc. 

 

 

Interfaces 

There are some main interfaces you will see while using Photo to 

FlashBook Professional as below shows: Application Options, Import 

Photo, Template Settings, Language Option, Output. 

You can enter into each page to get clear instructions for every detail 

option. 
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I. Application Options Interface 

Render Engine Option 

 

New version 3.0.0 provides 3 different render engines for you to create higher 

quality page-flipping eBooks, click "Options->Application Options" to enter into 

"Render Engine" interface: 

 

SWF: Much legible characters, smaller output size 

GPL Ghostscript: Higher color transfer quality 

Inner Library: Faster convert speed 

(Change option when PDF imported failed) 
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II. Import Images Interface 

 

Panel Description: 

1  Import images:  

 Click this icon  to open the PDF file you want to 

convert; 
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I. add images 

 

1. Image 

 

 

You can open Images from computer or digital camera: 

 

 Click this icon to choose Images from your computer or camera, or click 

"File->Add a Directory…" to add a folder of images together. 

 

2. Reorder Images 

 

Click "Action" in toolbar, then you will find different ways to reorder images: 
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(1) Move: 

 

Choose the file you want to move, click "Action" to reorder the images: Move First, Move Up, 

Move Down and Move Last. Or directly drag the image to the position you want it to be. 

 

(2) Sort: 

 

 

 

There are four types of Sort method you can use to reorder images, by name/ file size/ image 

size/ create time. 

 

(3) Rearrange: 

 

You can define paper order as some default mode or input order manually: 
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3. Optimize Images 

 

If you want to optimize your images before converting to flipbook, there are many tools listed in 

"Image" drop-down list: 

 

 

Here are some optimize interfaces: 
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(1) Rotate: 

 

 

(2) Crop: 
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(3) De-skew: 

 

 

(4) Convert to Black/White: 
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4. Output Settings 

 

After optimizing images, you can define page layout or set other options for outputting 

flipbook or PDF. 

(1) Output Quality: 
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(2) Output Layout: 

 

You can define how many pages to be imposed into a flipbook page or click "Custom" icon to 

set your wanted page columns and rows: 

 

 

 

Or click "Customize…" to enter into "Setting" interface as below shows (You will be able to 

set Page size, orientation, margin, layout, position for the pages): 
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(3) Image Transform: 

 

 

 

(4) Bookmark Settings (for outputting PDF files): 
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(5) PDF Watermark (for outputting PDF files): 

 

 

 

 

 

 

 

5. Output 

 

Choose output as "Build to Flipbook" to enter into template setting interface: 

 

 

2. The Page Ranges to Import: 

 Convert all pages to page-flipping eBook; 

Convert defined range page; 

 Just preview effect on first 10 pages. 

3. Watermark 

 Add image or text watermark to flipping pages. 

Check this option first to choose default stamps or add new ones: 
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4. Page Quality 

There are five types of "Quality And Size": 

 

5. Other Options: 

 Select this option to use first page's 

proportion as book proportion, or you can define in Template Setting interface; 

If your PDF file contains bookmarks, check this option to use in output 

page-flipping eBook; 

If your PDF file has links, check this to enable in flipbook; 

Check this option to enable search functionality in created flipbook. 

At last, click  icon to enter into template setting interface. 
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III. Template Settings Interface 

 

It provides three different templates at present: Classical, Float and Spread.  

Each template contains some unique settings, the below instructions will 

show you details. 

 

The design setting interface contains below main parts: 

Choose Template 

Book 

Sound 

Tool Bar 

Bookmark 

Initial Show 

Links 

Language 

Security Settings 

Render Engine Option 
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Panel Description:  

1. Choose Template: 

 

Click icon to select templates from below interface: 

 

2. Book Panel: 

 
 



PDF to Page-Flipping eBook Utility 

 

User Document 

Copyright 2010 by FlashBookMaker.com 

- 21 - 
 

(1) Book Title (only can be set in Float Template): 

 
Customize book title for showing on the top of your flipbook. 

 

(2) Hide Book Frame Bar: 

 

If don’t want to show the book frame bar, choose “Yes” in this option. 

 

(3) Retain the book to center: 

 
If you select “No” in this option, the eBook will be shown on the right-side. This setting is for 

embedding special background image, such as advertisement or company log. 

 

(4) Book Proportions:  

 

Please note that the values are not fixed in pixels or inches, they just represent a ratio for 

"Page Width: Page Height", and the book size will be changed depend on your Explorer 

Window Size. 

 

 



PDF to Page-Flipping eBook Utility 

 

User Document 

Copyright 2010 by FlashBookMaker.com 

- 22 - 
 

(5) Book Margin: 

  

A. Book Margin (set in Classical Template): 

 

"Book Margin" refers to the distance between the book and the toolbar. 

 

B. Top/ Bottom/ Left/ Right Margin (set in Float/ Spread Template): 

 

 

(6) Flash Window Color: 

 

This color will be applied on all flash windows, such as the book window, "Help" window, 

"Print" window and so on. 

 

(7) Icon Color (only in Classical Template): 

  

(8) Page Background Color: 
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When load pages, or if the page number of your PDF file is odd, then the page (the last page) 

will show with the "Page Background Color". 

 

(9) Page Shadow: 

 

The value also takes the value of Book Proportions as reference, and the value interval of 

"Page Shadow Opacity" is "0~1", the larger value refers to the deeper shadow color. 

 

(10) Background Config: 

 

A. Background Color:  

 

Define background for your flipbook with gradient color or pure color (the same color for 

"Gradient Color A" and "Gradient Color B"). Gradient Angle is the angle between the two 

colors. 
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B. Background Image setting in Classical and Spread templates: 

 
Click the icon " " to choose background image from your computer, and there are 11 kinds 

of "Image Position" for you to choose: Scale to fit, Fill, Top Left, Top Center, Top Right, 

Middle Left, Middle Center, Middle Right, Bottom Left, Bottom Center and Bottom Right.  

 

C. Background Image setting in Float template: 

 

The Float template enables you to add two background images: Outer Image and Inner 

Image. You can make Inner background image to show special information, such as 

advertisement or company logo, etc. There are also 11 kinds of "Image Position" for you to 

choose: Scale to fit, Fill, Top Left, Top Center, Top Right, Middle Left, Middle Center, Middle 

Right, Bottom Left, Bottom Center and Bottom Right. 

 

(11) Right to Left: 

If the language of your file is read from right to left (such as Arabic), then choose "Yes" in 

"Right to Left" option: 
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(12) Hard Cover: 

If you want create hard cover effect (a book bound with rigid protective covers) for your 

flipbook, choose "Yes" in "Hard Cover" option: 

 

 

(13) Flipping time: 

Sets page flipping time in seconds according to your 

needs. (Recommended second value is 0.6) 

 

3. Sound Panel: 

 

If you want to add background sound to your flipbook, such as a song or other audio file, set 

"Enable Sound->Enable", then click " " icon to choose "Sound File" from your computer, 

then set "Sound Loops", "-1" stands for playing the sound file all the time while viewing 

flipbook, other value (N>0) stands for the times of playing the sound file. 

 

4. Tool Bar: 
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(1) Tool bar (only in Classical Template): 

 Show or Hide Tool bar in created flipbook. 

 

(2) Zoom Config: 

 

To Enable Zoon In functionality, choose ''Yes" in "Zoon in enable", then set "Zoom Scale", the 

value is the times between zoomed page size and the current page size. 

 

(3) Print Enable: 

 

Choose "Yes" in "Print Enable", then click icon  to set print page range as below: 

 

 

(4) Search Button: 

 

Select "Show" in "Search Button" (make sure you have check "Enable Search" option in 

"Import PDF" interface), then define "Search Highlight Color", after clicking "Search" icon 

, you will see a popup box to input search words, then click Enter or "Search" button, 

you will get the below searching result: 
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(5) Download setting: 

  

If you want your flipbook readers to download the PDF file or the flipbook directly from your 

website, select "Yes" in "Download Enable" option, then input the Download URL directly, 

you can use absolute path like 

"http://www.FlashBookMaker.com/flip-pdf/example/files/download/FlipPDFDemo.pdf" or 

relative path like "/files/download/FlipPDFDemo.pdf" (make sure you have uploaded the 

PDF to the same path). 

Then readers can click the icon  to download your uploaded PDF file directly. 

 

(6) Full Screen: 

To enable "Full Screen" functionality in output flipbook, select "Show" in "Full Screen 

Button" option:  

Then you can click icon  to view flipbook in Full Screen, click icon  or "Esc" 

button to exit from the Full Screen. 

Or if you want to show your flipbook without Tool Bar while showing in Full Screen mode, 

you can set "No" in "Full Screen without Tool Bar" (just in Classical Template): 

 

 

(7) Help Button: 

To show tips about viewing flipbook, you can set "Show" in "Help Button" option:

 

Then you can see the button  and click to get the tips as below: 
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(8) Share Button: 

If you want your flipbook viewers to send the link to their friends or clients, you can add a 

share button in your flipbook for readers to send out your flipbook link immediately: 

 

When the viewers click the share button , they will enter into the Email interface with 

the link of your flipbook in the Email body. 

 

(9) Auto Flip: 

To auto flip your eBooks, you can set "Yes" in "Auto Flip->Enable" option; then define the 

Flip Interval (seconds of staying on each page); the value of "Play Count" stands for the times 

of auto playing the eBook, and "-1" stands for playing forever (after clicking the Auto Flip 

button , the flipbooks will be flipped by staying 3 seconds per page); if you want to 

auto start and flip the eBook after opening, just set "Auto flip when start up->Yes": 

 

 

 

5. Initial Show (set in Float/ Spread Template): 

You can show Bookmark panel or Thumbnails panel on the flash page at the beginning, just 

select "Bookmark" or "Thumbnails" in this option: 

For Example, select "Thumbnails":  

Then you will get flipbook shown with below initial interface: 
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6. Bookmark: 

 

In "Design Setting" panel (only in Classical Template, in other templates, the colors will be 

adjusted automatically based on your defined flash window color), you can set "Font color", 

"Background color", "Background alpha" (refers to the background opacity, value interval: 

0~1, "0" stands for the background is totally transparent), "Always Show Bookmark->True/ 

False" and "Panel Position->Left/ Right". 

In "Bookmark" panel, if you didn't check "Import bookmark" option in "Import PDF" 

interface, or you want to create new bookmarks for your flipbook, you can add bookmarks 

even sub-bookmarks here, click "Add" icons and then input "Title" and "Page". 

When click the bookmark button , it will popup the bookmark panel immediately, and 

click on those bookmarks, it will jump to the defined page automatically 
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7. Links: 

 

If you have check "Import links" option in "Import PDF" interface, then you can define 

settings here, choose "Mouse over color", "Link alpha" (refers to the link area opacity, value 

interval: 0~1, "0" stands for the area is totally transparent), "Border color", "Border width" 

and "Open Window->Blank/ Self". 

 

8. Language 

  

You can set language for showing tools or tips in your created flipbook, and here is the 

specialized instruction page for setting the "Language Option". 

 

9. Security Settings: 

 

If you want to protect your flash books with passwords, you can click "…" icon to enter into 

"Flash Security Config" interface: 
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Select "Security Type->Single Password", and input passwords into the box (there is no 

restriction on password format at present). You can also set "Protect Page Range" as "All 

Pages" or the latter pages after a defined page number. (Tips: The program utilize RC4 

algorithm to protect eBook pages, the eBook content pages will show nothing without 

permission.) 

At last, click  icon to apply the settings 

IV. Language Options Interface 

Click "Option->Flash Language", you will enter into the Language Settings interface as below 

shows: 

 

Panel Description: 

As the tips explaining, the "Labled" column lists the buttons and instructions on Flash books 

in defined language, and the program provides you five different languages for you to use: 

English, Chinese Arabic, French and Greek.   

 

You can also add other language for your own uses: 

1. Click the button  and define name for the new language: 
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Click "OK" to save the new language in the list; 

 

2. Choose the first label and click "Edit" icon, define new language text in "Labeled" box, 

then click "Save And Edit Next": 

 
 

3. At last, you can get all Labels translated into your new language as the images shows: 

 

You can delete unwanted language:  

Or save your edited new language file as XML or TXT file:  

Load language file saving before for current using:  
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V. Output Interface 

 

 

Output types: 

1.  

This output type is for uploading created page-flipping ebook onto websites: 

 

You can define HTML Title and other properties by clicking "Advanced" button:  

  
Set Keywords, Description or even Script in the below interface: 
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2.  

This output type is for compressing the created files into an integral ZIP package which can 

be sending out as attachment directly. You can also define HTML Advanced Settings by 

clicking "Advanced" icon:  

Your recipients just need to uncompress the ZIP file and then they can view the HTML 

flipbook instantly: 

 

3.  

This type is for outputting flipbook as a single executive file, easy storing and easy viewing:  

 

You can also define Icon and Opening Window Size in Advanced Settings: 
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You can even burn the output flipbook to CD: 

 

After choosing output type, then check the option "Burn to CD", set "CD Writer", define 

"Disc title", at last click button to output flipbook in your defined type. 

VI. Batch Convert Interface 

 

 

Panel Description: 

 

1. Add PDF Documents: 

Click this icon to add PDF files from computer; 

 Click this icon to add all PDF files in the folder (include sub-folders). 

 

You can also remove some unwanted PDF, move up/ down files, or clear all documents.  
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2. Settings: 

 

(1). Output Settings: 

 

  i. Choose Output Type: 

 

  ii. Choose Output Path: 

 

 
 

You can also define output name pattern with FileName, Title, Subject and so on: 

 

 

And after defining the File Name, you can preview the result example below: 

 

 

  iii. Define Output Option: 

 

 

Click "Advanced" icon to define Keywords, Description for HTML flipbooks, or define Icon, 

Window Size for EXE flipbooks: 
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  iv. Merge All PDF Files to One Flip Book: 

 

 

 

 

 

 

(2). PDF Settings: 

 

  i. Page Range: 

 

 

You can convert "All pages" or just "Custom range"; 

 

  ii. Watermark: 

 

 

Click "Set Watermark" icon to enter into "Watermark" interface: 
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Check "Applying Watermark" option, then you can choose default stamps, Edit them, or Add 

Text Watermark, Add Image Watermark, Delete, Move Down/ Up. 

 

 

 

 

 

  iii. Page Quality: 

 

Choose quality and size type from listed five kinds. 

 

  iv. Other Options: 

 

 Select this option to use first page's 

proportion as book proportion, or you can define in Template Setting interface; 

 

If your PDF file contains bookmarks, check this option to use in output 

page-flipping eBook; 

 



PDF to Page-Flipping eBook Utility 

 

User Document 

Copyright 2010 by FlashBookMaker.com 

- 39 - 
 

If your PDF file has links, check this to enable in flipbook; 

 

Check this option to enable search functionality in created flipbook. 

 

 

 

 

At last, click  icon to batch convert listed files together. 

 

 

 

 

 

 

 

License Agreements   

 

All copyrights to Photo to FlashBook Professional (the Software) are exclusively owned by 

FlashBookMaker.com. For more information, visit our website at 

www.FlashBookMaker.com . 

 

Anyone may use this software but all the page-flipping eBooks generated will automatically 

have a demo watermark on the first page of them. To remove the limitation you must 

register. 

 

Once registered, the user is granted a non-exclusive license to use the Software on one 

computer (i.e. a single CPU) at a time. The registered Software may not be rented or leased, 

but may be permanently transferred, if the person receiving it agrees to terms of this 

license.  

 

The Software unregistered (trial) version may be freely distributed, provided the distribution 

package is not modified. No person or company may charge a fee for the distribution of the 

Software without written permission from the copyright holder.  
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THE SOFTWARE IS DISTRIBUTED "AS IS". NO WARRANTY OF ANY KIND IS EXPRESSED OR 

IMPLIED. YOU USE AT YOUR OWN RISK. THE AUTHOR WILL NOT BE LIABLE FOR DATA LOSS, 

DAMAGES, LOSS OF PROFITS OR ANY OTHER KIND OF LOSS WHILE USING OR MISUSING THIS 

SOFTWARE. 

 

You may not use, copy, emulate, clone, rent, lease, sell, modify, decompile, disassemble, 

otherwise reverse engineer, or transfer the licensed Software, or any subset of the licensed 

Software, except as provided for in this agreement. Any such unauthorized use shall result in 

immediate and automatic termination of this license and may result in criminal and/or civil 

prosecution. 

 

All rights not expressly granted here are reserved by A-PDF Solution. 

 

Installing and using the Software signifies acceptance of these terms and conditions of the 

license. 

 

If you do not agree with the terms of this license you must remove the Software files from 

your storage devices and cease to use the product. 

  

 

How to Order 

 

Order Online (http://www.FlashBookMaker.com/flippingbook-maker/index.html) or Order 

Toll Free 1-877-353-7297 (When you order toll free just give the operator the product 

number of the product you would like). 

 

How to purchase online?  

 

1. Select a license type above, and click [Buy Now] 

 

2. Select the currency that you want to use. (You can also continue shopping) 

 

3. Fill billing information and select a payment method. (Your information is safe with us) 

 

4. Check the information you filled previously and click "Place Secure Order"  

 

Other Order Ways—With Phone/Mail/Fax/Check: 
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If you are not comfortable ordering online with a credit card, you are welcome to choose an 

offline order option in the payment section of the order process. We accept mail, fax, wire, 

and PO (if applicable) ordering options in addition to ordering online. We also provide 

phone orders through our 24x7 order desk at 1-877-353-7297, or (952) 646-5331 for 

International Callers.  

 

Please note that all of the offline ordering options do have additional fees for processing. To 

place an order by mail, fax, wire, and PO (when applicable), use the online form and then 

choose one of these payment options found in the Payment Method section of the form. 

Once submitted online, the appropriate information will be provided to you in your web 

browser to send your payment to us offline. 

 

100% unconditional 30 Day Money Back Guarantee 

 

 

Want to custom the program or have other questions about purchase? 

Contact us at support@FlashBookMaker.com . 

 

 

 

Support 

You can easily search or browse our frequently asked questions, and learn tutorials about 

products, and get your registration code back. If you don't get a satisfying solution, please 

contact support team for help. 

 

1. Frequently Asked Questions 

You can find answers to questions about technique issues here: 

http://www.FlashBookMaker.com/general-support.html  

2. Learn tutorial about Photo to FlashBook Professional 

We publish a video tutorial which shows you the easy procedure of dealing with Photo to 

FlashBook Professional, you can view this video to quickly handle the stunning tool: 

http://www.FlashBookMaker.com/flippingbook-maker/flippingbook-creator.swf 

 

3. Get lost license code 

Click here to look up the order » (http://www.regnow.com/cs/orderStatus) 

You can pull up a copy of your order by entering your email address. After you find your 

order, you may view its status, view details of your order (including the license key), and 
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obtain the invoice.  

 

4. Contact Us  

If you have other questions or requirements, contact us directly through our support Email: 

support@FlashBookMaker.com, we will respond you ASAP. 
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